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This tutorial is written for developers who want to develop Qt/C++ applications using the
Eclipse IDE under Windows. Though there are many online resources regarding this issue, I
decided to write a complete step-by-step how-to being as user-friendly as I only can. I hope I
will succeed... :)

Requirements and installation

To be able to use Eclipse IDE for Qt/C++ development you only need a few things. In
this section I try to list these requirements and the procedure of the installation of each
component.

What you will need:
- Eclipse Europa C++ IDE (fall2)
- Java 5/6 Runtime Environment or SDK (I will use the SDK for now)
(I assume you already have a working Java 5/6 JRE/SDK)
- Qt 4.3.3 Opensource Windows MinGW build
- Qt Eclipse Integration Plug-in 1.0.1 MinGW build

a. Downloading and installing Eclipse Europa IDE
Go to http://www.eclipse.org/downloads and select Eclipse IDE for C/C++
development

Eclipse Europa Fall Maintenance Packages - Windows (compare packages)

. Tu Eclipse IDE for Java Developers - Windows 78 MB) Windows
.~ >
k( The ezsential tools for any Java developer, including & Java IDE, a CWS client, XML Editar and Mylyn. Linux
Find out more... Mac 05 X
Eclipse IDE for Java EE Developers - Windows (126 MB) Windows
JEE Tools for Java developers creating JEE and Weh applications, including a Java IDE, toals for JEE and JSF, Linux
{===1 Mylynand others. Java 5 {or higher) required. Find out more... Mac 05 X
< Eclipse IDE for CIC++ Developers - Windows (B3 MB) Windows
‘\J A |DE for CiC++ developers. Find out more... Linux
g Mac 05 X
_ Eclipse for RCPIPlug-in Developers - Windows (153 ME) Windows
=‘J_;' = A complete set of tools for developers wha warnt to creste Eclipse plug-ins or Rich Client Applications. i Linux
includes & complete SDK, developer tools and source code. Find out more... Mac 05 X
: Eclipse Classic 3.3.1.1 - Windaws (140 ME) A
. The classic Eclipse download: the Eclipse Platform, Javs Development Tools, and Plug-in Development i

Enviranment, including source and hath user and programmer documentation. Find out more.. Mac 05 X
Release notes | All Versions | Documentation

Getting Eclipse Europa

After downloading extract the zip file in a folder.
HINT: You should create a ,root” folder for your development environment. In this
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example the root directory will be c:\devtools

You should now have a folder called c:\devtools\eclipse.
Go to the folder and start Eclipse for the first time.

eclipse

Europa

Starting Eclipse for the first time

When starting Eclipse for the first time you need to set up a workspace where all
your future projects will be stored. To do so enter a path in the pop-up dialog seen
on the picture below.

& Workspace Launcher |z|

Select a workspace

Eclipse Platform stores wour projects in a Folder called a workspace.
Choose a waorkspace Folder ko use Faor this session,

Warkspace: |C:'|,D|:u:uments and Settingsimfx-leclipseiworkspac v| [ Browse, ., ]

[ JUse this as the default and do not ask again %

oK H Cancel ]

Creating a new workspace

After this Eclipse should start up with the welcome screen.
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& CIC++ - Eclipse Plaiform

Fle Edit Refactor Mavigste Search Run Project Window Help

[ e
Workbench
Go to the workbench
L3

Eclipse welcome screen

On the welcome screen click on the ,Workbench” icon to launch the workbench. A
default perspective should appear.
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& CiC++ - Eclipse Platform =]
AUW Edit Refactor Navigste Search Run Project Window Help
vl . = = .
!&W . AltShift+h SR B its-0-Q- i@ e ik 5 [ | @@ e+ |
pen File - —
El = OB outin 51 @ make | © T
| A autling is not avalable,

Rename. . F2
Refresh FS
Convert Line Delimiters To »

Switch Workspace 3

| gy Import.
| e Expart...

Properties Ale+Enter

T

(26 problems 52 . ] Tasks | B console | =] praperties | %Hv=0
0errors, 0 warnings, O infas
Description - Resource Path Location
LR @items selected im0 B @ %

Eclipse default workbench with C/C++ perspective
Ok. So far so good. Now exit Eclipse by clicking on , File->EXxit".

b. Installing Qt 4.3.3 for Windows
To get Qt go to http://trolltech.com/downloads/opensource.

Scroll down the page to find various packages for supported platforms and choose
the ,Qt Open Source Edition for C++ Developers: Windows Download”.

Qt Open Source Edition for C++ Developers

download description

Qt Open Source Edition for C++ Developers: Windows Download

Q Gtis a cross-platform application developrmeant framewaork, The Cpen Source
ml.ﬂb Edition of Gt iz available to open source developers under the terms of the GRL
version 2.0, and is not intended for commercial, proprietary source projects, %
" Qt Open Source Edition for C++4 Developers: Mac Download
:Q Qt iz & cross-platform application developrnent framework, The Gpen Source
mm Edition of Gt iz available to open source developers under the terms of the GPL

version 2.0, and is not intended for commercial, proprietary source projecs.

. Qt Open Source Edition for C++ Developers: X11 Download
@ Qt iz a crozz-platfarmn application developraant frarmewark, The Open Source
mm Edition of Gtis available to open source developers under the terms of the GPL

version 2.0, and is not intended for commiercial, proprietary source projecs,

Select an appropriate mirror and download the installer exe.

Download from ftp.trolitech.com:

gt-win-opensource-src—4.2.2.2ip (about 48 Mk

gt-win-opensource-4.2.3-mingw.exe (about 70 Mh)

After the download has finished, run the installer and follow the steps.
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£ Qt OpenSource 4.3.3 Setup

Choose Components

Choose which features of Gt Opengource 4.3.3 vou want ko
install,

Check the components wou wank to install and uncheck the components wou don't want to
install. Click Mext bo continue.

Select components ko install: ck 4.5 .5 F).es.Frlptlnn

File Associations

S

Space reguired: 233, 1ME

< Back. ” L:gxt}- l [ Cancel ]

E' Qt OpenSource 4.3.3 Setup

Chooze Install Location
Choose the Folder in which ko install QF OpenSource 4.3.3,

Setup will inskall QF Opendource 4,33 in the Following Folder, Toinskall in a different Folder,
click Browse and select another Folder, Click Mext ko conkinue,

Dreskination Folder

I||:||:||5'I| k T i Browse. ., |

Space reguired: 233, 1IME
Space available; 2,366

< Back. ” Mexk = ] [ Cancel

Select folder to install Ot in
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E' Qt OpenSource 4.3.3 Setup

MinG% Installation

Please specify a directory where ko find MingW (For instance: CHAMinEW, IF vou do nok
have MinaW installed, vou can let the installer download and install it For you,

Download and install minimal MinGsy installation. (hktp: e, mingw, org)

Find MinEi

Download and inskall MinGt

Installation directory:

___ devko -:II "1 inia ! E]

[ < Back. ” Mext = ] [ Cancel ]

When asked for MinGW select "Download and install a minimal MinGW
installation" and set MinGW installation path

E' Qt OpenSource 4.3.3 Setup

MinG'W License Agreement

Please review the license kerms befare installing MinGy,

MinaWy License Information

| GMNLGEMERAL PUBLIC LICEMSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Evervone is permitted to copy and distribute werbatim copies
af this license document, but changing it is nok allowed.,

Preamble

I The_licenses_ for mast s_chtware are designed ta Lake away your

If wou accept the kerms of the agreement, click. I Agree to continue, You musk accept the
agreement ko inskall Gt Opensource 4.3.3,

« Back “ I Aree ] [ Cancel
2
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E' Qt OpenSource 4.3.3 Setup

by Ferenc STELCZ

MinGY Download Mimor
Select a download mirear,

Tr' ollbech (Flormay)

5

(T | s o s ey By | B e o 2 y
PRUNSETE AT SEEI: 2 S0, Zila

[ ] pownload MinEw source code. (¥ou don't need this to compile Q)

[ < Back. ”

Install

] [ Cancel

Select a mirror but don't select "Download MinGW source code.”

MinGW Download

@ Dowwnloading MinG'W from server..

[----F
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E' Qt OpenSource 4.3.3 Setup

by Ferenc STELCZ

Inztalling
Please wait while Qt OpenSource 4.3.3 is being installed.

Extract: docihtmlidialogs-configdialog-configdialog-cpp. html

[lﬂ'ﬂ'ﬂ'ﬂ'ﬂl

Extract: docihtmlideskiop-systray-main-cpp.html L. 100%:

Extract: docihtmlideskiop-swstray-swstray-gro.html ... 100%:
Extract: docihtmlideskiop-swstray-window-cpp. bkl L. 100%:
Extract: docihtmlideskiop-swstray-window-h. bkl .. 100%:
Extract: docihtmlideskiop-systray html ... 100%:

Extract: docihtmldeskiop.html ... 100%

Extract: %('l,html'l,dialags-classwizard-classwizard-cpp.html v 100%:
Extract: docihtmlidialogs-classwizard-classwizard-b.html L, 100%
Extract: docihtmlidialogs-classwizard-classwizard-gro, html ... 100%:
Extract: docihtmlidialogs-classwizard-main-cpp.html ... 100%:
Extract: docthtmlidialogs-classwizard bkl L. 100%:

Extract: docthtmlidialogs-configdialog-configdialog-cpp. bkml

[

E' Qt OpenSource 4.3.3 Setup

TR LITECH  Completing the Qt OpenSource
Code Less. Create More. 433 Se’(up wWizard

Click. Finish to close this wizard,

[ Jrun Examples and Demos

[]show Document ation

Qt OpenSource 4,3.3 has been installed on wour compuker,

< Back, |_ ITiqish J [ Cancel
i

c. Installing the Eclipse integration plug-in

While you are on the Trolltech website get the Qt Eclipse Integration Plug-in as well.
To get it go to http://trolltech.com/developer/downloads/qt/eclipse-integration-

download
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Qt Eclipse Integration for C++
The Eclipse plugin can be used to create programs using any Ot verSiR{n since 4,1.0.

Downloads
platform spec.iﬁcéﬁ';i.n usage g[.uii':le_]n-._é:s. built with version du:l.l.ilnlnad
Windows Win32 Al editions Ot 4.3.32 Cownload
Linux (32 bit) gee 3.3 Al editions Ot 4.3.3 Download
Limnux [32 bit) gco 4 All editions Ot 4.3.3 Cownload

Select ,Download” in the row of Windows and save the executable. When finished
downloading run the installer of the plug-in.

£ Ot Eclipse Integration 1.0.1 Setup

TR LITECH  Welcome to the Qt Eclipse

Code Less. Create More. Integration 1.0.1 Setup Wizard

This wizard will guide wou through the installation of Gt
Eclipse Inteqgration 1.0.1,

It is recommended that vou close all okther applications
before starting Setup. This will make it possible to update
relevant system files without hawving to reboot wour
cornpuker,

Click. Mext bo continue,

[ Mext = l [ Cancel
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E Qt Eclipse Integration 1.0.1 Setup

Choose Install Location
Chonose the Folder in which ko install Ot Eclipse Inkegration 1.0.1.

Setup will install O Eclipse Integration 1.0.1 in the following Folder, Toinskall in a different
fFolder, dlick Browse and select another Folder. Click Mext to continue.

Destination Folder

devtaols\ Tralkech|Eclpse | [Leronse... ]

Space required: 7.2ME %
Space available: 2.0GE

[ < Back ” Mext = l [ Cancel

You can enter a destination path for installation - this is not so important

E" Qt Eclipse Integration 1.0.1 Setup

Eclipse Installation Location
Select where eclipse is inskalled, and where MinigW is located.

Eclipse Installation

Select the Eclipse installation wou want to use;

| Cdevtoolsheclipse | [:]

rinGw Inskallakion

Select where MinaW is installed (The directory where goc.exe is located):

| CiidevtaolsiWinGwibin 1

If wou don't specify a MinGW location, wou will not get a shorbout invou skartmenu ko
skark Eclipse with MinEW in waur path,

[ < Back. ” Install ] [ Cancel ]

This screen is very IMPORTANT - Enter the path of your Eclipse installation
and the path of your MinGW bin directory
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E Qt Eclipse Integration 1.0.1 Setup

Installation Complete
Setup was completed successfully.

Completed

[HHHHHlﬂHHHHHHHHHHlHHHHHHHHHHHHHHHHHHHHHHHHHHHHHMHﬂﬂﬂﬂﬂﬂlq

Extract: adddialog.h,.. 100%: Y
Extract: adddialog.ui,.. 100% =
Extract: addressbook.cpp,.. 100%

Extract: addressbook.h... 100%

Extract: AddressBoaok.pro,,, 100%:

Extract: addressbook,ui... 100%

Extract: main.cpp... 100%

Created uninstaller: C:\devtoolsi Trollkech!Eclipseiuninst. exe

Create shortouks CiDaocuments and Settings)all Users)Skart MenuiProgramsior Eclip, ..
Create shortouk; ChDocuments and Settings)all UserstSkart MenuiProgramsiot Eclip, ..

Cukput Folder: Cidevtools Trollkech\Eclipse =
Completed % B
MllsErE Irstall Sastem w2 27 -

< Back, Mext = Cancel

£ Ot Eclipse Integration 1.0.1 Setup

TR 'LITECH  Completing the Qt Eclipse

Code Less. Create More. Integration 1.0.1 Setup Wizard

0k Eclipse Integration 1.0.1 has been installed on wour
compuker.

Click. Finish to clase this wizard,

% Back Finish Cancel

After installing the Eclipse plugin everything should be ready for developing Qt
applications using Eclipse except one thing - environment variables for MinGW.

11



Eclipse with Qt4 Integration Plug-in on Windows XP HOW-TO by Ferenc STELCZ

The MinGW bin dir is by default not added to the pATH variable of your system. To
fix this, right click on ,My Computer”, select Properties->Special Tab->Environment
variables. Find the value ,path”, select ,Edit” append a , ; " and the path of your
MinGW bin directory.

Rendszervdltozo szerkesztdse

Yalkozd neve: |—E-ath |

Waltoza értéke: | 1 Sk rn 32 Wiy R e e N (e e |

[_ ] 4 ][ Mégse ]

I,
Adding the MinGW bin directory to your PATH
environment variable

Ok, almost! :)

Before you begin, you need to fix a little ,bug” in Eclipse. It's documented and
should be fixed. If you have a shortcut to Eclipse on your desktop, right click it ->
~Properties” and append a ,-clean” (without quotemarks) to the executable, as
seen below.

Eclipse Europa - C++ IDE tulajdonsdgai |i||g|

| Alalanos | Parancsikon | Kempatibiltas

I% Eclipse Europa - C++ IDE

Cél tipuza: Alkalmazas

CE&l helye: eclipse

Cél: iE:'xdevtu:u:-ls'xeu:lipse'xeu:lipse.e:-ce -zlean |

Inditas helye: | C:hdevtoolzheclpze

[
Billentyiiparancs: | Mincs by |
|
|

Futtatas: | Marmal ablak. M

hMegjegyzés: | |

[Eél kerezése. . ][ lkonczere. .. ][ Speciliz. . ]

ok || Megse || Akaimaz

12
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So now you are really ready. :) Let's start Eclipse! If everything is OK, after
selecting the previously created workspace, you should get a screen like this:

& Qt Eclipse Integration

This workspace has been launched the First time
1:/ with the QF Eclipse integration.

Do wou wank to launch the Qt Cheat sheet now?

You can also launch it via (Help = Cheat sheets,.. = Gt development), later

Yes ] [ Mo ]

Eclipse starts up and asks you if you want to launch the ,Qt Cheat Sheet”. Click on
yes and read the tutorial on how to create Qt applications using Eclipse.

Additional comments:

- Before doing anything you need to set which Qt install to use. To do this, in
Eclipse select ,Window->Preferences” and the ,Qt” item in the tree. Click on ,Add".
Fill in the version name box (for example with 4.3.3), then in the ,Bin path” line
click on ,Browse” and select your Qt install's bin directory (for me it is
C:\devtools\gt\bin). The rest will be filled automatically. Click on ,Finish”. In the
settings dialog, select the new Qt installation item (4.3.3) and click the ,Default”
button. This makes the current Qt installation to be the default to use by Eclipse.

- AFTER creating a new Qt project via ,File->New->0Other...->Qt", you have
to add the Qt includes to your project. To achieve this, right-click your project in the
«~Project Browser” select ,Properties”. In the settings dialog choose ,,C/C++ Include
Paths and Symbols”. Click on ,Add External Include Path...” and add all subfolders of
$QTDIRS\include\ (for example C:\devtools\gt\include\QtCore,
C:\devtools\include\gt\QtGui and so on...). You can simply add
C:\devtools\gt\include but then the C/C++ Indexer of Eclipse won't index
methods/functions found in the subdirectories...

I hope you will succeed and have fun developing applications using Qt/Eclipse. ;)
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